
RSB Work Session
Tuesday, May 26, 2026 6:00 PM
ZOOM, 500 Big Dog Salmon Way, Angoon, AK 99820

1. Call Meeting to Order

2. Discussion  Items

2.1. 26-27 Harmony Alaska Handbook

2.2. Policy Review: Continued AASB policy updates.
1-BP 4112.1/4312.1 - CERTIFICATED PERSONNEL AND MANAGEMENT AND 
SUPERVISORY PERSONNEL - CONTRACTS
2-BP 4112.5/4212.5/4312.5 - ALL PERSONNEL - SECURITY CHECK
3-AR 4112.5/4212.5/4312.5 - ALL PERSONNEL -– SECURITY CHECK
4-BP 4112.6/4212.6/4312.6 - ALL PERSONNEL - PERSONNEL RECORDS
5-BP 4112.10 -– CERTIFICATED PERSONNEL - EMPLOYMENT OF RETIRED 
TEACHERS
6-BP 4112.61/4212.61/4312.61 - ALL PERSONNEL - EMPLOYMENT REFERENCES

 
2.3. District Calendar review: Two options, each has 
been edited to accommodate requested changes.

2.4. Update to FY 2027 Budget

2.5. Letter from the commissioner approving our 
request for $200,000.00 in restored revenue for 
this year.

3. Board Member Comments

4. Adjourn Meeting
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Program Overview & Welcome 

 
Dear Parents and/or Guardians, 

 

Welcome to Harmony Educational Services-Alaska. We are so glad you’re here! 

We work in collaboration with Chatham School District.  Our mission is to support families across 

Alaska who are dedicated to educating their children at home. Our story began in 2015 when Tenakee 

Springs, one of our district's small island communities, faced the closure of its local school. Rather 

than seeing this as a loss, four families and a dedicated school board member reimagined what 

education could look like. They created a public homeschool program rooted in the needs of their 

vibrant community. 

 

Since then, we have partnered with Harmony and have grown into a statewide program, but we’ve 

never lost that small-town spirit. We remain committed to providing a flexible, family-driven 

experience that honors your expertise in deciding what is best for your students. 

The following pages contain the essential information you’ll need for the coming year, but please 

consider this just the starting point. While you take on the vital work of home education, Harmony is 

here to walk alongside you. Our team is available to help guide you through your journey, please never 

hesitate to reach out with questions. 

 

Thank you for letting us be part of your student’s education.  

 

Warmly, 

 

Megan Moody 

 

 
 

 
​
 



Who this program is for 
Our program  is designed for families who value flexibility, personalization, and partnership in their 
child’s education.  
This program is a good fit for families who: 

●​ Want to homeschool with the support of certified teachers 
●​ Value flexibility in schedule, pace, and learning style  
●​ Prefer learning that can happen anywhere; at home, in the community, or outdoors. 
●​ Want access to allotment funding, curriculum options, and guidance 
●​ Appreciate a partnership through the learning process 
 

How Correspondence Education Works 
Correspondence education in Alaska allows families to educate their children at home while remaining 
enrolled in a public school program. This model combines family-led learning with school-based 
support and accountability. 
In a correspondence program: 

●​ Students are enrolled in a public school but do not attend daily in-person classes 
●​ Parents or learning coaches guide day-to-day learning at home 
●​ Certified teachers provide oversight, guidance, and progress monitoring 
●​ Learning is documented and shared through regular check-ins and work samples 
●​ Students may still participate in required state assessments 

 
Shared Responsibility Model Overview 
We operate under a shared responsibility model, meaning learning is a partnership between families 
and the program.   
 
Families are responsible for: 

●​ Supporting daily learning at home 
●​ Helping students get started and stay engaged 
●​ Saving periodic work samples or evidence of learning 
●​ Communicating with their mentor at least monthly 
●​ Meeting basic participation and reporting requirements 

 
Our Program is responsible for: 

●​ Providing access to certified teachers and mentors 
●​ Supporting curriculum planning and progress discussions 
●​ Monitoring participation and academic progress 
●​ Administering state and program-required assessments 
●​ Managing allotment funding, policies, and compliance 

 



This model is designed for the family and the program to work together to ensure students benefit 
from flexibility and support. 
 

Enrollment, Registration, & Withdrawal 
Enrollment Eligibility  
Harmony has an open enrollment for all eligible students in K-12 as provided in AS 14.17.600. A 
student must be 5 years old as of September 1st to enter Kindergarten. A student cannot be over the 
age of 20 before September 1st unless he/she qualifies for Special Education Services. 
 
Registration Requirements  

●​ New Student Registration Packet 
●​ PowerSchool Pre-Registration Form 
●​ Harmony Orientation 
●​ Child’s Birth Certificate 
●​ Proof of Alaska Residency (i.e. electric bill, etc.) 
●​ Home Teacher Agreement   
●​ Individualized Learning Plan (ILP)   
●​ Student record request form (only if transferring from another school district)  
●​ Current Immunization Records or exemption forms (only if your student plans to take a 

class at their local school or join in a public school extracurricular such as sports or music) 
 
Key Dates & Important Windows 
These are the main dates families should be aware of during the school year. You don’t need to 
memorize them, think of this as a quick reference. 
 
School Year Milestones 
July 1 – Allotment money available 
September 15 – ILP due 
October 15 – 1st quarter progress report & work samples due   
January 15 – 2nd quarter progress report & work samples due  
March 15 – 3rd quarter progress report & work samples due  
May 5 – Grades due for Seniors participating in graduation.  
May 15 – 4th quarter progress report & work samples due  
 
Assessments   
These assessments apply only to certain grade levels. 
Fall/Winter/Spring – Dibbles reading assessment (K-3 students) 
October – Kindergarten Developmental Profile 
March-April – State assessment (grades 3-10) 
  



Allotment & Ordering Windows (at a glance) 
July 1 – October 31 – Resource Ordering Window 
December 1 – January 31 – Resource Ordering Window 
April 27 – Final date for Allotment Requests or reimbursements 
 
Details about what can be ordered or reimbursed are explained later in the handbook. 
 
Special Needs Students 
CSD provides all special education services as required by state and federal law to enrolled students in 
collaboration with Harmony. Any funding necessary for IEP related services are provided outside the 
student’s allotment..   Special needs students will receive narrative reports and grades based on 
progress toward goals stated in their Individual Education Program in light of their exceptionalities.  
 
Full Time Enrollment  
Full-time enrollment is defined for elementary students as having 4 courses taken through the 
correspondence program with at least 2 of the courses being core classes. For High School, full-time 
enrollment is 4 courses or 8 semesters with at least 50% of those courses being core classes. However, 
while 4 courses meets the minimum requirements for full-time enrollment and funding, this is not 
typically sufficient for students who are on track to graduate. To meet graduation requirements, high 
school students are generally expected to complete approximately 6 credits per year.  
 
Dual Enrollment / Public School Participation  
Our families are entitled to enroll their children in a public education program part-time. In this 
situation, a student may take a maximum of 2 courses per semester through their in-person public 
school and at least 2 courses through Harmony (although we suggest 4 or more courses through 
Harmony in order to have a full courseload). Students who are dual enrollment receive a half 
allotment. Students will need to have their local school principal or district official sign off on the dual 
enrollment form in order for us to submit for correct funding. Due to the complexity of scheduling and 
credits at elementary grade levels, requests will be considered on a case by case basis.  
 
Dual Enrollment / Public School Participation (CSD Students Only) 
If you live in the Chatham School District and enroll in Harmony you may take advantage of the 
facilities and opportunities CSD provides. Students may take an elective course or two at their public 
school, participate in extracurricular activities, participate and travel with sports and academic teams, 
walk in graduation, use facility library or other public venues (they must be supervised by a parent) 
and otherwise be part of the social network of your community’s school. Students may also participate 
in local school field trips such as transition camp, or any other field trips organized by the local school 
or correspondence program (although not individual classroom field trips). Students participating in 
district-sponsored activities or events are subject to applicable district policies and codes of conduct. 



 
Dual Enrollment with Private or other Educational Programs 
Students may enroll in a private school or other educational program while participating in the 
correspondence program.. 
All coursework used to meet enrollment and funding requirements must be included in the student’s 
approved ILP and delivered under the supervision of the correspondence program. 
Courses taken outside the program may supplement a student’s educational experience; however: 

●​ Coursework may not be duplicated for funding purposes 
●​ Public funds may not be used to pay for substantially similar courses offered through 

another institution 
●​ The student’s overall course schedule may be reviewed to ensure compliance with state 

regulations 
 
Grade Level Placement 
Grade level is determined by the review of prior records and documentation of previous grade level 
completed. Students' date of birth, prior grade level as designated by the last school of record, and 
prior testing records may also be used to determine grade level. High School students will be placed 
according to the number of credit hours earned.  
Freshman  ​​   9th grade  ​ Successfully pass 8th grade 
Sophomore ​ 10th grade ​ 5 ½ credits  
Junior   ​ ​ 11th grade ​ 11 credits 
Senior     ​ ​ 12th grade  ​ 17 credits 
 
Acceleration/Retention-Middle and Elementary School 
The district seeks to promote student progress with peers while accommodating individual learning 
needs. To accomplish this, instruction will accommodate the varying interests and growth patterns of 
individual children and include strategies for providing extra attention when needed. A student may be 
considered for acceleration only if the following can be clearly demonstrated: that acceleration will be 
beneficial to the student socially, emotionally, and academically; and there is no other way to provide 
for the student’s needs. Formal and informal test scores and physical and social development may be 
considered in making this determination.  
 
As long as adequate instruction is demonstrated, retention of a student is rarely recommended. If 
retention is recommended or requested, district policy will be followed. The correspondence team, 
working with parents, will make the final decision on retention.  
 
Health records/immunizations 
Students who attend school ONLY by correspondence are not required to be immunized, however, all 
students who PHYSICALLY attend school (including correspondence students who might attend for 
short periods of time) or participate in organized school activities must meet Alaska immunization 



requirements. There are medical and religious exemptions from the Alaska immunization regulations. 
The state regulations that deal with medical exemptions are 4 AAC 06.055(b)(2) and 4 AAC 
62.450(c)(1). 
 
Withdrawal Procedures 
A student may withdraw at any time, however, students who withdraw prior to the end of the first 
quarter will be held accountable for all expenditures and will be required to return all materials.  To 
withdraw, please complete a withdrawal form and turn it into your mentor. If you withdraw your child 
during the course of the year, or if your child is unable to complete the entire year’s curriculum by the 
beginning of the next school year and chooses to return to another school, the grade level placement 
will be up to the receiving school’s principal. Records will be sent to the enrolling school upon receipt 
of a student record request.  

●​ All non-consumable materials (technology, special equipment, etc.) purchased with 
allotment funds must be returned to the Harmony in a timely fashion. Parents may be 
financially liable for damage or missing items.    

●​ Purchase requests or reimbursements dated on or after the withdrawal date will not be 
honored.    

●​ Student records will not be released until all parent obligations are fulfilled and financial 
obligations are met.  

 
Non compliance/non participation Withdrawal 
Our program may withdraw a student at any time during the school year if the home teacher 
agreement (which was signed during registration) is not being adhered to.  Examples of 
Non-Compliance that could result in withdrawal include: 

●​ Not responding to repeated communication attempts by the contact teacher or mentor. 
●​ Not submitting student work samples in a timely manner. 
●​ Students demonstrating little or not attempt to complete school courses. 

Harmony in collaboration with CSD will give every effort and work diligently with families and 
students to support them in their homeschooling efforts. Sometimes a student’s needs are better 
met in a different method of instruction. In this case we will do our best to find a more suitable 
avenue for your child’s educational needs.  
 
Tiered Intervention Process for Non Participation 
 
Tier 1: Reminder & Support 
If required documentation (work samples, progress reviews, contact, etc.) is missing: 

●​ The family will receive notification from CSD via email outlining what is needed. 
○​ A clear deadline will be provided. 
○​ The mentor will offer support and schedule time to assist if needed. 
○​ Allotment ordering may be temporarily paused until documentation is received. 



The goal at this stage is clarity and support, most concerns are resolved here. 
 
Tier 2: Formal Notice 
If documentation is still not received by the stated deadline: 

●​ A second written notice (certified letter) will be mailed outlining outstanding 
requirements. 

○​ The allotment account will remain on hold. 
○​ The family will be given a final deadline to submit required materials. 

At this stage, the program is required to document active follow-up. 
 
Tier 3: Withdrawal for Non-Participation 
If adequate participation or required documentation is not provided: 

●​ A certified withdrawal notice will be mailed to initiate withdrawal for non-participation. 
○​ The effective withdrawal date will be clearly stated. 
○​ A final transcript will be included if applicable. 

Withdrawal decisions are based on state participation requirements and documentation standards.    
 
Re-Enrollment After Withdrawal 
Families who are withdrawn may request re-enrollment in a future semester or school year. 
Re-enrollment is reviewed on a case-by-case basis and may require resolution of prior participation 
concerns. 
 
Late Enrollment  
Students applying for enrollment after the count period will be considered on a case-by-case 
basis. 

●​ Allotments may be prorated for students enrolling during the October count period. 
●​ Students enrolling after the count period: 

○​ Do not receive an allotment 
○​ Are not eligible for computer or internet benefits 
○​ Have access to limited curriculum options, focused on core instructional needs 

Enrollment continues, but support is adjusted based on funding availability and time 
remaining in the school year. 

 
Roles & Responsibilities Overview 

 
Parent / Home Teacher Responsibilities 
In our correspondence program, learning is a partnership. Parents (or designated home teachers) 
guide daily instruction, while Harmony provides oversight, support, and accountability. 
 
Daily Instruction & Support 



 
The parent/home teacher agrees to: 

●​ Guide day-to-day learning aligned with the approved Individual Learning Plan (ILP)  
●​ Create a consistent learning environment and schedule 
●​ Monitor progress and help students stay on track 
●​ Supervise required assessments when applicable 
●​ Work toward completing the ILP within the school year​

 
Even independent learners benefit from regular check-ins and adult guidance. 

 
Communication & Participation 
Regular communication helps ensure students are progressing appropriately. 
Parents will: 

●​ Connect monthly with their assigned teacher or mentor (This can be via a short phone 
call, an email, in person, or a longer conference) 

●​ Participate in quarterly progress conversations to discuss student progress and grades 
●​ Submit required work samples and progress documentation 
●​ Keep contact information current 
●​ Check email at least weekly. Email is the primary information flow for Harmony.   

 
These checkpoints allow us to celebrate growth, adjust plans when needed, and document 
academic progress. 

 
Documentation & Work Samples: 
Families collaborate with program staff to: 

●​ Develop a written Individual Learning Plan (ILP) (in collaboration with program staff) 
for the student that meets or exceeds Alaska Standards and grade level expectations.   

●​ Submit quarterly progress reports with grades 
●​ Submit work samples quarterly for each subject on the ILP   

○​ Work samples may include written work, projects, photos with short descriptions, 
assessments, presentations, or other evidence that demonstrates progress. 

○​ Documentation is not meant to add pressure, it helps create a clear record of 
learning over time. 

 
State Assessments 
To make sure the student is present to participate in mandatory state assessments or sign district 
approved “opt– out” form.  

 



Student Responsibilities 
Students enrolled in Harmony are active participants in their own learning. Expectations will 
look different based on age and grade level, but all students are encouraged to take increasing 
ownership of their education over time. 
 
Participation in Learning Activities 
Students are expected to: 

●​ Engage in daily learning activities outlined in their Individualized Learning Plan (ILP) 
●​ Participate in discussions, projects, and hands-on learning experiences 
●​ Attend required assessments or scheduled check-ins when applicable 
●​ Make a consistent effort toward academic growth​

 
Completion of Assigned Work 
Students will: 

●​ Complete coursework and assignments to the best of their ability 
●​ Submit work in a timely manner   
●​ Revise or improve work when feedback is provided 
●​ Work steadily toward meeting grade-level expectations​

 
Communication & Accountability (Age-Appropriate) 
As students mature, they are encouraged to: 

●​ Take responsibility for asking questions when they need help 
●​ Participate in progress conversations 
●​ Reflect on their learning and set goals 
●​ Practice organization and time management skills​

 
Independence develops over time. The goal is gradual growth in responsibility, not perfection. 
 
Certified Teacher Responsibilities 
Each student enrolled in Harmony is assigned a certified teacher. The certified teacher serves as 
the district’s academic liaison and point of contact for required documentation and reporting. 
 
Academic Liaison Role 
The certified teacher: 

●​ Reviews and approves the ILP in collaboration with the parent/home teacher 
●​ Confirms that planned coursework aligns with Alaska standards 
●​ Serves as a resource when academic questions arise 
●​ Provides feedback on submitted work samples​

 



The certified teacher does not direct daily instruction. Parents remain responsible for day-to-day 
teaching and instructional decisions. 
 
Documentation & Reporting 
The certified teacher: 

●​ Reviews quarterly work samples 
●​ Confirms required documentation has been received 
●​ Finalizes semester progress reporting 
●​ Ensures required state assessments are documented​

 
This role helps maintain alignment with district and state participation requirements while 
allowing families flexibility in how learning occurs. 
 
Partner Program Responsibilities 
CSD partners with Harmony Educational Services to provide additional family support. 
Harmony mentors serve as a planning and guidance resource for families enrolled in the 
program. 
 
Mentor Support  
Harmony mentors serve as a primary day-to-day support contact for families. Their role is 
advisory and supportive. 
Families may contact their mentor for assistance with: 

●​ Curriculum and resource selection 
●​ Planning schedules and pacing 
●​ Developing or adjusting learning goals 
●​ Reviewing progress and documentation before submission 
●​ Clarifying timelines and participation expectations 
●​ Problem-solving challenges as they arise 
●​ Allotment use and purchasing guidelines 
●​ Ordering and reimbursement timelines 
●​ Documentation expectations 
●​ Next steps when participation questions arise 

Mentors provide encouragement, organization support, and practical guidance throughout the 
school year. 
 
High School Counseling Support 
Harmony provides access to a high school counselor to support long-term academic planning. 
 
Counseling support may include: 

●​ Graduation requirement planning 



●​ Credit tracking and transcript review 
●​ Course sequencing and pacing 
●​ Postsecondary planning (college, career, training programs) 
●​ Adjusting academic plans when goals change​

 
Final authority regarding enrollment status, documentation approval, grading, and district 
compliance remains with CSD. 

Curriculum & Grading 
  

Individual Learning Plan (ILP) 
All students enrolled in Harmony must have an approved Individual Learning Plan (ILP).  The 
ILP serves as the academic roadmap for the school year. The ILP is developed collaboratively 
between the parent/home teacher and the assigned Harmony mentor.  When applicable, students 
may participate in the planning process.   
 
The ILP must: 

●​ Outline courses of study for the school year 
●​ Align with Alaska state standards 
●​ Include a plan for ongoing assessment 

 
Curriculum, instructional services, and materials must align with the approved ILP in order to be 
eligible for reimbursement. The ILP must be completed and approved at the beginning of each 
school year and becomes part of the student’s official academic record. Any significant course 
changes during the year must be reviewed and approved by the assigned certified teacher.  
Continued enrollment in the correspondence program requires ongoing academic participation 
and submission of required documentation. Students are considered in attendance when engaged 
in documented instructional activities aligned to their approved ILP. 
 
Work Samples 
Students are required to submit work samples for each subject listed on the ILP in accordance with 
state correspondence regulations.  
 
Core Course Requirements   
To be considered full-time, students must be enrolled in a minimum of four courses (8 semester 
classes) through Harmony. In accordance with Alaska regulation 4 AAC 33.426, a student 
enrolled in a statewide correspondence program, whether full-time or part-time, must take at 
least 50 percent of his/her coursework through the statewide correspondence program in core 
subject areas.  Core subjects include the primary academic areas required for graduation, such as 



Language Arts, Mathematics, Science, and Social Studies. This requirement may be waived for 
extenuating circumstances such as fulfilling graduation requirements.   
 
Curriculum Selection 
Families may select curriculum that aligns with the student’s approved Individual Learning Plan 
(ILP) and grade-level expectations. 
Curriculum options may include: 

●​ Home-based instructional materials 
●​ Approved online courses 
●​ District-supported instructional programs 
●​ Pre-approved third-party instruction​

 
All curriculum, instructional services, and materials must be included in the approved ILP prior 
to purchase or reimbursement. 
Program staff are available to provide guidance if assistance is needed in selecting curriculum. 
 
Approved Instructional Options 
Approved Online Vendors 
Students may enroll in approved online curriculum providers. Available vendors may include: 

●​ ALEKS 
●​ BrightThinker 
●​ BYU Independent Study or Teacher-Led 
●​ DreamBox 
●​ Edgenuity 
●​ Edmentum 
●​ eDynamic 
●​ K12 
●​ MobyMax 
●​ Rosetta Stone 

Additional vendors may be considered upon review and approval. 
 
Flex Direct Courses 
Flex Direct courses are structured courses taught by certified teachers. 

●​ Instruction is delivered through guided coursework. 
●​ Pre-recorded instructional sessions may be available. 
●​ Assignments or progress checkpoints are submitted regularly. 
●​ Final grading and documentation are completed by the assigned certified teacher of 

record.​
 

 



Portfolio-Based Courses 
Portfolio courses allow families to design instruction aligned to the student’s ILP using the 
curriculum of their choosing. 

●​ Parents guide daily instruction. 
●​ Students compile work samples demonstrating progress. 
●​ Portfolios are reviewed quarterly by a certified teacher. 
●​ Final academic approval and grading remain under the authority of the Harmony 

program. 
 
Faith Based Curriculum 
Any faith-based material you deem appropriate for your child may be used in their schooling, 
including personally-purchased faith-based materials. As a public school district, state law 
prohibits us from using public funds for the advocacy of sectarian or denominational doctrines, 
but you are free to use any such materials that you purchase yourself. Credit may only be 
awarded for coursework that aligns with Alaska state standards and is reviewed by the assigned 
certified teacher. 
 
Dual Credit (high school) 
Harmony works with the University of Alaska's Dual Enrollment Program, called the Alaska 
Advantage Program. Through this program, eligible high school students may: 

●​ Earn both high school and college credit simultaneously 
●​ Take approved university courses 
●​ Begin college-level coursework early 

Students should consult with their certified teacher and high school counselor prior to 
enrollment. 
 
UA Scholars Scholarship   
The UA Scholar Award is awarded to the top ten percent of all graduating seniors from Alaska 
high schools.  It is a $12,000 scholarship to any of the 15 University of Alaska campuses. With 
over 500 degree and certificate programs to choose from, you are likely to find a program that 
will help you meet your career goals.  
 
Alaska Performance Scholarship   
Harmony students may be eligible to qualify for the Alaska Performance Scholarship (APS). The 
APS is a merit-based scholarship that provides an opportunity for any future Alaska high school 
graduate who meets a core set of requirements to receive funding to pursue college and/or career 
training in Alaska. Students must plan with their academic counselor to ensure they are on track 
for eligibility.   



 
Alaska Career Information System  
Plan your education and career with the Alaska Career Information System (AKCIS). AKCIS is 
available free of charge. AKCIS gives you the tools for a successful future. Students can build a 
career portfolio, take career assessments, research career options, set goals, find colleges and 
universities, learn about financial aid and more.   
 
Grade Level Expectations 
Planned coursework is reviewed by the assigned certified teacher to ensure alignment with 
Alaska state standards and district graduation requirements. 
For more information on Alaska standards:​
https://education.alaska.gov/standards 
 
HS Graduation Requirements (pending possible changes) 
Subject​​ ​ ​ ​ Credits 
Language Arts​​ ​ ​ 4 
Social Studies​​ ​ ​ 3* 
Mathematics​ ​ ​ ​ 3 
Science​ ​ ​ ​ 2 
Health ​​ ​ ​ ​ 0.5 
Physical Education​ ​ ​ 0.5 
Electives​ ​ ​ ​ 9 
TOTAL​ ​ ​ ​ 24 
*Note: 0.5 units of Alaska History is required 
 
Grading   
Grades reflect documented academic progress. 
 
Grades K-3​ ​ ​ ​  
O = Outstanding 
S = Satisfactory 
N = Needs Improvement 
 
Grades 4-12 
A = 90-100% ​​ Outstanding Achievement​ ​ ​ 4.0 grade points 
B = 80-89%​ ​ Above Average Achievement​​ ​ 3.0 grade points 
C = 70-79%​ ​ Average Achievement​​ ​ ​ 2.0 grade points 
D = 60-69%​ ​ Below Average Achievement​​ ​ 1.0 grade points 
F = 0-59%​ ​ Little or No Achievement​ ​ ​ 0 
I  ​ ​ ​ Incomplete​ ​ ​ ​ ​ 0 

https://education.alaska.gov/standards


Guidelines for Daily Instructional Time (Contact hours) 
The following represents recommended daily instructional averages:  

 Subject   Grades K-3   Grades 4-6  Grades 7-12 

Language Arts 120 135 135 

Math 45 55 60 

Science / Health 25 35 50 

Social Studies 25 35 50 

Physical Education 20 25 30 

Music/Art/Technology/
etc. 

15 30 35 

TOTAL 4 hours 5 hours 15 minutes 6 hours 

 
Daily instructional time averages are provided as guidance to support steady academic progress 
throughout the year. 

Allotment Funding & Technology 
 
Purchasing Guidelines & Spending Limits 
To ensure equitable and appropriate use of public funds, the following guidelines apply to all 
purchases made with student allotment funds. 
 
Student allotments provided through Harmony must be used exclusively for instructional 
expenses directly related to the enrolled student’s Individual Learning Plan (ILP). Core 
instructional materials should be prioritized before supplemental or extracurricular items.  
 
Purchases made without prior approval are not guaranteed reimbursement and may be denied. 
 
General Purchasing Requirements 
All purchases must: 

●​ Align with the student’s approved ILP 
●​ Serve a clear educational purpose 
●​ Be reasonable in cost and comparable to what a public school would provide 
●​ Be pre-approved when required. 

 



Approved Curriculum Purchases 

Harmony offers a variety of approved curricula to meet diverse academic needs. Parents should 
collaborate with their mentor to confirm that chosen curricula: 

● Align with Alaska state standards, 
● Are appropriate for the student’s grade level, and 
● Meet all program requirements. 

Faith-based curricula may be included on the ILP for credit purposes; however, these materials 
must be purchased privately by the family, as Harmony cannot reimburse or purchase faith-based 
curricula. 

Supplies and Materials 

Supplies must be educationally appropriate and linked to courses on the student’s ILP. Common 
allowable purchases include: 

● General school supplies (e.g., paper, crayons, scissors) 
● Limited general art supplies for projects 
● Reading materials such as books and learning subscriptions 
 

Eligible Expenses 
Eligible expenses may include: 

●​ Textbooks and workbooks 
●​ Instructional supplies 
●​ Science kits and lab materials 
●​ Educational software or online programs 
●​ Educational technology (see Technology section below) 
●​ Approved third-party instruction 
●​ Field trips or educational activities directly aligned with the ILP 
●​ Organizational or student use furniture (crates, shelves, desks, chairs) 

 
Ineligible Expenses 
State regulations prohibit the use of public funds for: 

●​ Religious, partisan, sectarian, or denominational materials 
●​ Services provided by a family member 

 
The district does not reimburse for: 

●​ Food, lodging, or non-educational travel expenses 
●​ Clothing that is usual and customary for everyday use 
●​ Extracurricular club or choir uniforms, badges, awards   
●​ Pets or ongoing animal care (vet bills, feed, etc.) 
●​ Items that present a safety or liability risk (e.g. power tools, trampolines, swimming 

pools, etc.) 



●​ Streaming TV, movie or music subscriptions 
●​ Personal-use items 
●​ Household items (TV’s, microwave, etc.) 
●​ Items purchased from a family-owned business 
●​ Licensing or certification fees not aligned with ILP coursework 
●​ Excessive or duplicate equipment 

Final determination of allowable expenses rests with district administration. 
 
Spending Limits by Category 
The following general spending limits apply: 

●​ Technology Devices (computers/tablets): up to $1,000 per student per device per year.  
●​ Special Equipment (e.g., musical instruments, sewing machine, drones, cameras, 

specialized tools): up to $800 per item. 
●​ Elective Course Supplies (gardening, home economics, small engines, shop) $300 per 

course. 
●​ Physical Education & Activity Equipment: up to $400 per student per year 
●​ Organizational or student use furniture: up to $350 per family per year 

 
These limits are intended to guide purchasing decisions and ensure consistent use of funds across 
students. If parents have questions regarding these limits or want an item that exceeds these 
limits, we encourage you to contact your mentor.  
 
The district does not partially fund individual items.  
 
Ownership of Materials & Equipment 
All non-consumable materials and equipment purchased with allotment funds are the property of 
the district. 
 
Families may not combine personal funds with allotment funds to purchase a single item. 
 
Consumable materials (such as workbooks, paper supplies, and curriculum that cannot be reused) 
do not need to be returned. 
 
Non-consumable items may be required to be returned in reasonable condition upon withdrawal 
from the program. The district may require reimbursement for items that are not returned, lost, or 
significantly damaged in accordance with district policy. 
 
Approval & Exceptions 
Some items or services may require pre-approval prior to purchase. 
 



Exceptions to standard spending limits may be considered on a case-by-case basis when justified 
by the student’s educational needs and approved in advance. 
 
Final determination of allowable expenses rests with district administration 
 
Ordering & Reimbursement Procedures 
Allotment funds are available for resource ordering on June 1.  
 
Allotment funds are available for reimbursement purchases from May 1 of the year enrolling 
through May 31 of the next year. Harmony starts reimbursement processing on August 15.  
 
Reimbursements can be sent to your Harmony mentor throughout the school year.  
 
Harmony processes resource orders during the following windows: 

●​ July 1 - October 31 (1st semester) 
●​ December 1 - January 31 (2nd semester)  

Families may choose one of the following options: 
1. Direct Ordering 
​ ​ Submit a wish list, and we'll purchase and ship items directly to you. 
2. Easy Reimbursement: 
​ ​ Prefer to shop independently? Buy approved items and receive prompt reimbursement. 
 
Third-Party Instruction Providers 
Families may choose to use student allotment funds for classes or lessons provided by approved 
third-party instruction providers, including tutors, community members, and local service 
providers. 
 
Instruction may include academic subjects, fine arts, physical education, cultural instruction, or 
other approved learning activities, provided the following requirements are met: 

●​ Instruction must be included in the student’s approved Individual Learning Plan (ILP) 
●​ Instruction may not be provided by a family member 
●​ Instruction must be nonsectarian when funded with public allotment funds 
●​ All providers must be pre-approved by the district prior to services being rendered 

 
Parent Responsibility and Acknowledgement 
Third-party instructors are not employees of Chatham School District or Harmony Educational 
Services. 
 
By requesting payment or reimbursement for third-party instruction, families acknowledge that: 

●​ The instructor is independently contracted by the family 



●​ The district does not supervise or evaluate the instruction provided 
●​ The district makes no guarantees regarding the quality, safety, or outcomes of services 
●​ The family assumes responsibility for selecting and overseeing the instructor 

 
Third-Party Instructor Approval Requirements 
All third-party instructors must complete the following prior to providing services: 

●​ District-approved background check (completed through the district’s approved process) 
●​ Third-Party Instructor Information Form and W-9 
●​ Pre-Approval for Third-Party Instruction Form 

 
The district reserves the right to deny or revoke approval of any provider based on background 
check results. 
 
Payment Procedures 

●​ All services must be pre-approved prior to the start of instruction 
●​ Payment will only be made for approved services after instruction has taken place 
●​ Services provided prior to approval may not be eligible for payment 

 
Payment Options 
There are two ways to pay for third-party instruction using allotment funds: 
 
Direct Payment to the Instructor 
Harmony can pay the instructor directly. 

●​ The instructor completes the Third-Party Instructor Payment Form after services are 
provided 

●​ The parent submits the completed form to Harmony for payment 
 
Reimbursement to the Family 
Families may pay the instructor directly and request reimbursement. 

●​ The parent pays the instructor 
●​ The instructor completes the Third-Party Instructor Payment Form 
●​ The parent submits the completed form to Harmony for reimbursement 

 
Steps to Use Third-Party Instructors 

1.​ Choose an instructor​
Tutor, coach, music teacher, cultural educator, etc.—not a family member 

2.​ Connect with the instructor​
Confirm availability, services, and cost 

3.​ Submit the Pre-Approval for Third-Party Instruction Form​
This starts the approval process 



4.​ Instructor completes required forms​
Third-Party Instructor Information Form, W-9, and background check 

5.​ Wait for approval​
You will be notified when instruction can begin 

6.​ Begin instruction 
7.​ Instructor completes the Third-Party Instructor Payment Form and provides it to the 

parent; the parent selects the payment option and submits it to Harmony 
 
Note: Services that begin before approval may not be eligible for payment. 
 
Internet Access & Reimbursement 
Internet service may be reimbursed when internet access is necessary to support coursework 
included in the approved ILP. There is no cap on the amount of your allotment funding you 
would like to allocate to internet usage.   
Internet reimbursement: 

●​ Must be pre-approved 
●​ Requires families to submit bills each month or semester via reimbursement form. 
●​ Is subject to available allotment funds 
●​ Is limited to one household per family 

 
Unused Funds & Rollover 
Unused allotment funds may roll over to the following academic year provided the student 
remains continuously enrolled and in good standing.  
 
Rollover is subject to district policy and available funding. 

 
State Assessments & Reporting Requirements 

 
As a statewide correspondence program, Harmony must comply with Alaska statutes and 
regulations governing public education. Students enrolled in Harmony are expected to complete 
coursework and meet applicable state educational requirements. 
 
Statewide Assessments  
AK-STAR (State Summative Assessment) 
AK-STAR assessments are administered by the Alaska Department of Education and Early 
Development (DEED).  
 
Students in grades 3–10 are assessed in English/Language Arts and Mathematics. Students in 
grades 5, 8, and 10 are also assessed in Science. 
 



Testing occurs at designated Chatham school sites, typically in March or April, with specific 
dates varying by community. 
 
Harmony encourages student participation in statewide assessments. These assessments provide 
valuable feedback regarding academic progress and contribute to district reporting requirements. 
 
MAP Growth (Benchmark Assessment) 
Students in grades 2–12 may participate in MAP Growth assessments three times per year. 
MAP is a computerized, adaptive assessment that measures academic growth and helps guide 
instructional planning. Results provide families and teachers with data to support individualized 
learning decisions. 
 
Participation is encouraged as part of ongoing progress monitoring. 
 
Alaska Kindergarten Developmental Profile (KDP) 
All kindergarten students and first grade students entering the district who have not previously 
been assessed complete the Alaska Kindergarten Developmental Profile (KDP), as required by 
DEED. 
 
The KDP evaluates developmental readiness in areas including motor skills, language and 
communication, general knowledge, and social development. 
 
Alternate and Additional Assessments 
Some students may participate in additional required assessments based on program or individual 
needs: 

●​ Students with significant cognitive disabilities may participate in alternate assessments 
(Dynamic Learning Maps-DLM) as determined by their IEP 

●​ English Learners participate in ACCESS for ELLs annually 
●​ Early literacy assessments (such as mCLASS) may be administered in grades K–3 
●​ Some students may be selected for national assessments (NAEP) 

 
Opt-Out of State Assessments 
Parents/guardians have the right to opt their child out of statewide assessments. 
Families choosing to opt out must: 

• Notify your mentor by January​
• Complete and submit the opt-out form 

Students with an approved opt-out form on file will not be scheduled for statewide testing. 
 
Monthly Contact 
Families are required to maintain monthly contact with their assigned certified teacher or mentor.  



 
Monthly contact may occur through an office visit, phone call, video conference, or email 
communication. 
 
Regular contact supports student progress monitoring, ensures alignment with the approved ILP, 
and allows for timely identification of concerns or additional resource needs. 
 
Failure to maintain required monthly contact may impact enrollment status, as consistent 
communication is a requirement of statewide correspondence programs. 
 
Quarterly Grades & Progress Reporting 
Families are required to submit quarterly progress reports four times per year. In cases where 
students are taking online courses directly offered and monitored by Harmony, mentors will 
assist in submitting these reports.  
 Each report must include: 

• A progress review for every course listed on the approved ILP​
 • A grade for each course​
 • Work samples  (for portfolio courses and non Harmony courses) 

 
For grades K–3, descriptive indicators such as Outstanding (O), Satisfactory (S), or Needs 
Improvement (N) are recommended. Families may also include examples of student work to 
demonstrate progress. 
 
For grades 4–12, traditional A–F letter grades are required. 
 
Work samples must be submitted for all ILP courses. For courses that do not produce traditional 
written assignments, acceptable documentation may include: 

• Written summaries​
• Journals​
• Activity logs​
• Photographic documentation​
• Course completion summaries 

Documentation should clearly indicate: 
• Lessons completed out of total lessons​
• Approximate time spent per week​
• Major topics studied​
• Skills mastered 

Once reviewed and verified by the assigned certified teacher, grades are entered into official 
student records each semester. Grades for students in K–8 are recorded in cumulative files. 
Grades for students in 9–12 are recorded on the official district transcript.  



 
Mentors and teachers are available to assist parents with these reports.  
 

Student Records & Privacy (FERPA) 
CSD maintains student education records in accordance with the Family Educational Rights and 
Privacy Act (FERPA). Parents/guardians have the right to review their child’s educational records 
and request correction of inaccurate information. 
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certain facts and circumstances which would lead a person, through the exercise of reasonable 
care, to know about a certain condition.  Constructive knowledge may include, but is not 
limited to, situations where an employer:  (i) fails to complete or improperly completes the 
Employment Eligibility Verification Form, I-9; (ii) has information available to it that would 
indicate that the alien is not authorized to work, such as Labor Certification and/or an 
Application for Prospective Employer; or (iii) acts with reckless and wanton disregard for the 
legal consequences of permitting another individual to introduce an unauthorized alien into its 
work force or to act on its behalf.  Knowledge that an employee is unauthorized to work may 
not be inferred from an employee’s foreign appearance or accent. 

All new employees shall show appropriate documents which certify that they are legally eligible 
to work in the United States, as required by law.  Nothing in this policy is intended to preclude 
the employment of teachers under the Exchange Visitor program in 22 C.F.R § 62.24. Legal 
Reference: 

UNITED STATES CODE 
8 U.S.C. 1324  Immigration and Nationality Act, as amended by Immigration 
Reform and Control Act of 1986 and Immigration Act of 1990 

CODE OF FEDERAL REGULATIONS 
8 C.F.R. Part 274(a)  Control of Employment of Aliens 
22 C.F.R. §62.24 Teachers 

Revised 12/2025 
9/92 
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Note: Pursuant to AS 14.20.130 the School Board may issue contracts after January 1 each 
year. 4 AAC 18.010 specifies minimum requirements for teacher and administrators contracts. 
Contracts must be signed by at least two School Board members and the teacher. 

After January 1, the School Board may issue teacher and principal/administrator contracts for the 
following school year. Contracts shall be approved by the School Board and signed by at least 
two School Board members. 
Note: AS 14.20.145 grants automatic reemployment rights to teachers who are not dismissed or 
given notice of nonretention or layoff. Nontenured teachers must be given notice of 
nonretention or layoff by the end of the school year. Tenured teachers must be given notice of 
layoff or nonretention before May 15. (See 4117.6) 

The School Board shall give or mail reemployment contracts to teachers who are not dismissed 
or given notice of nonretention or layoff in accordance with law. If an employee fails to notify 
the Superintendent or designee within 30 days after receipt of a contract of reemployment that 
he/she accepts reemployment, the School Board shall consider the employee to have declined 
reemployment and shall terminate the employee's services at the expiration of the existing 
contract. An employee on leave must still comply with the 30-day deadline. 
 
(cf. 4117.4 - Dismissal) 
(cf. 4117.6 - Nonretention) 
(cf. 4119.21/4219.21/4319.21 - Codes of Ethics) 
Note: Pursuant to 4 AAC 18.021 substitute teachers employed for the remainder of the school 
term when more than 20 school days remain must be employed under employment provisions 
for regular teachers. 

Legal Reference: 
ALASKA STATUTES 

14.20.130 Employment of teachers and administrators 
14.20.145 Automatic Reemployment 
14.20.158 Continued contract provisions 
14.20.010 Teacher certificate required 
14.20.020 Requirements for issuance of certificate 
14.20.120 Statement of qualifications 
14.20.215 Definitions 
14.20.620 - 14.20.650 Interstate agreement on qualification of educational 
personnel 
14.30.250 Teacher qualifications 

ALASKA ADMINISTRATIVE CODE 
4 AAC 05.080 School curriculum and personnel 
4 AAC 12.300-4 AAC 12.900 Certification of professional personnel 
4 AAC 18.010 Teachers' and administrators' contracts 
4 AAC 18.021 Employment of substitute teachers 

Revised 12/2025 
9/92 
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BP 4112.5/4212.5/4312.5 - ALL PERSONNEL - SECURITY CHECK 
Note: The following sample policy is based on material from the Juneau School District and 
may be modified or deleted as needed. 

The School Board desires to hire personnel whose background, conduct, and behavior reflect the 
highest standards of integrity and professionalism, and are deemed appropriate for work with 
children. The District will investigate the background of all applicants (including volunteers) 
prior to hire in the district. This investigation will include questions related to an applicant's 
background and criminal history, including a background check, and may include a fingerprint 
check. 
Falsification or omission of information during the interview or on the application shall be 
grounds for immediate removal from consideration for a position or dismissal from a currently 
held position. For certified staff, a complaint may also be made with the Alaska Professional 
Teaching Practices Commission (PTPC).  
Revised 12/2025 
9/92 
 
 
 
 
 
 
 
 
 
 
 

AASB Policy Reference Manual 

AR 4112.5/4212.5/4312.5 - ALL PERSONNEL – SECURITY CHECK 
Note: The following sample regulation is based on material from the Juneau School District 
and may be modified or deleted as needed. 
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1. No individual will be hired by the district until a background investigation has been 
completed. Under emergency circumstances, the Superintendent or designee can waive 
this requirement to allow someone to work until the investigation is complete. 

2. No person who has ever been convicted, or plead guilty or no contest (including forfeiture 
of bail) to a crime involving violence or sexual abuse will be hired by the district. 

3. No person who has been convicted, or plead guilty or no contest (including forfeiture of 
bail) to (1) a felony or (2) a crime or other violation involving a controlled substance 
within the five years preceding the application, will be hired by the district. If more than 
five years have elapsed since the crime or violation, a person may apply pursuant to the 
following paragraph. 

4. Applications from persons who have been convicted, or plead guilty or no contest 
(including forfeiture or bail) to any crime or violation (excluding minor traffic violations) 
not covered in (2) nor (3) will be considered by the Superintendent or designee on a case 
by case basis and notice given to the School Board prior to hire or being hired by the 
district. 

5. If charges are pending, no action will be taken on the individual's application until 
disposition of the charges. 

Revised 9/01 
9/92 
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BP 4112.6/4212.6/4312.6 - ALL PERSONNEL - PERSONNEL RECORDS 
Personnel records shall be kept for all current employees and shall include information usually 
expected in good personnel administration. Records shall be kept for all former employees, 
including such information as shall seem appropriate to the administration. 
Note: The Alaska Supreme Court has upheld a broad policy of public access to records and has 
ruled that employment applications of police chief and city manager may not be exempt from 
disclosure in view of the public's strong interest in high level public officials. It is likely 
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therefore that Superintendent or designee applications, and possibly other employee 
applications, are subject to public disclosure. 

(cf. 1340 - Access to District Records) 
(cf. 3580 - District Records) 
(cf. 1312.1 - Complaints Concerning Personnel) 
Note: 4 AAC 19.040 exempts employee evaluations from public disclosure and requires 
districts to establish procedures as to which supervisory personnel may have access to 
evaluation documents. AS 14.20.149 provides that information provided to a district under the 
district's certificated employee evaluation system is not a public record and is not subject to 
public disclosure. The Alaska Supreme Court in Anchorage Daily News has held that the 
evaluation of head public librarian is a public document. AASB recommends public requests 
for evaluations of district administrators be reviewed with district legal counsel on a case-by-
case basis. 

All personnel files are confidential and shall be available only to the employee, persons 
authorized by the employee, the Superintendent or designee, and those individuals authorized by 
the Superintendent or designee or School Board in accordance with administrative procedures. 
The School Board may collectively request to review an employee's file at an executive session 
of the School Board, pursuant to a specific employee action and/or complaint process, and in 
accordance with the Alaska Open Meetings Act 
Employees shall be notified whenever derogatory information is to be placed in their personnel 
files. Employee may review and comment on the contents of their personnel file. Personnel 
records shall be made available for inspection by the employee at an off-duty time. Inspection 
shall take place in the presence of an administrator. 
Legal Reference: 

ALASKA STATUTES 
44.62.310 Government meetings public 
40.25.120 Inspection and copying of public records 
23.40.070 Declaration of Policy (PERA) 
14.20.149 Employee Evaluation 

ALASKA ADMINISTRATIVE CODE 
4 AAC 19.040 Use of the evaluation 

Municipality of Anchorage v. Anchorage Daily News, 794 P.2d 584 (Alaska 1990) 
City of Kenai v. Kenai Peninsula Newspapers, Inc., 642 P.2d 1316 (Alaska 1982) 

Revised 12/2025 
9/92 
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BP 4112.10 – CERTIFICATED PERSONNEL - EMPLOYMENT OF RETIRED 
TEACHERS 
Note: Effective November 8, 2018, AS 14.20.136 authorizes schools districts to hire retired 
teachers in cases of teacher shortages. Retired teachers hired under this statutory provision may 
elect to continue receiving TRS benefit payments during the period of reemployment. A 
contract for reemployment of a retired teacher hired under AS 14.20.136 may not be for more 
than 12 consecutive months. Under AS 14.20.020(g), a retired teacher may teach as a long-
term substitute for not more than 165 consecutive days of a school term. 
If the teacher retired under the defined benefit retirement system, the teacher must be retired 
for at least 60 days if 62 years of age or older, or at least six months if under 62 years of age, 
before reemployment. In addition, if the teacher is reemployed by the same district that 
employed the teacher upon retirement, the teacher must certify that there was no prearranged 
agreement with the school district to hire the teacher after retirement. 
Prior to the hire of retired teachers under this statute, the school board must adopt a policy that 
permits the employment of retired teachers who are qualified to teach in those disciplines or 
specialties in which a shortage of teachers exists. The policy must describe the circumstances 
that constitute the shortage. 
This optional policy may be utilized by districts desiring to hire retired teachers in cases of 
teacher shortages, as authorized by AS 14.20.136. 

It is the policy of the Board that teacher vacancies be filled in a timely manner by qualified 
personnel. The District administration is authorized to employ retired teachers in accordance 
with AS 14.20.136 in cases of teacher shortages, and to notify the Administrator of the Teachers’ 
Retirement System that it is hiring retired teachers pursuant to that statutory provision. 
The hiring of retired teachers is authorized in those disciplines or specialties in which a shortage 
of teachers exists despite active recruitment efforts. A shortage is deemed to exist for those open 
positions that the administration has been unable to fill with qualified candidates, despite 
recruitment, public advertising for at least 10 business days, interviews, and the offering of 
positions to qualified candidates, if any. 
The hiring of retired teachers under this policy is distinct from a teacher holding a retired teacher 
certificate under 4 AAC 12.380. 
(cf. 4111/4211/4311 Recruitment and Selection) 
Legal Reference 

ALASKA STATUTES 
14.20.136 Employment of member of teachers’ retirement system 
14.25.043 Reemployment of retired members 
14.20.165 Restoration of tenure rights 

Revised 12/2025 
AASB POLICY REFERENCE MANUAL 
9/92 
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BP 4112.61/4212.61/4312.61 - ALL PERSONNEL - EMPLOYMENT 
REFERENCES 
The School Board desires to provide information about district employees to prospective 
employers to the extent that such information is factual and does not violate an employee's 
privacy rights. 
The Superintendent or designee is responsible for processing all requests for references, letters of 
recommendation, or information about employee performance, including the causes or reasons 
for separation regarding all district employees other than the Superintendent. 
References which are not secured through the Superintendent or designee reflect the personal 
views or opinions of the author and do not reflect the views of the District. 
(cf. 4112.6/4212.6/4312.6 - Personnel Records ) 
(cf. 4117.5/4217.5/4317.5 - Termination Agreements) 
Legal References: 

ALASKA STATUTES 
AS 09.65.160  Job References 

Revised 12/2025 
9/92  
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BP 4113 - CERTIFICATED PERSONNEL - ASSIGNMENT 
Note: The following sample policy may be revised or deleted to reflect district 
philosophy.  This subject area is covered by collective bargaining laws.  

The School Board recognizes strategic assignments are essential to supporting student success 
and maintaining a healthy, consistent school environment. While assignments must comply with 
applicable laws and credentialing requirements, the strengths, experiences, and well-being of 
district staff are important considerations. Since both students and staff benefit from stability, 
continuity, and positive relationships, assignment decisions should also consider the impact on 
school climate by minimizing unnecessary disruptions, and promoting consistency in student-
teacher relationships.       
The Superintendent or designee may assign certificated personnel to any position for which their 
preparation, certification, experience and aptitude qualify them.  Teachers may be assigned to 
any school within the district.  Teachers shall not be assigned outside the scope of their teaching 
certificates or their fields of study except as allowed by law. 
(cf. 4112.8/4212.8/4312.8 - Employment of Relatives) 
Note: The following optional paragraph should be reviewed in conjunction with the district's 
collective bargaining agreement, if any, and revised or deleted as appropriate.   

The assignment of certificated personnel shall comply with applicable collective bargaining 
agreements and alternative and charter school contracts. 
Legal Reference: 

ALASKA STATUTES 
14.20.147 Transfer or absorption of attendance area or federal agency school 
14.20.148 Intradistrict teacher assignment 
14.20.158 Continued contract provisions 
23.40.070 Declaration of policy (PERA) 

UNITED STATES CODE, TITLE 20 
Every Student Succeeds Act, P.L. 114-95 

Revised 12/2025 
AASB POLICY REFERENCE MANUAL 
9/92  
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BP 4115 – CERTIFICATED PERSONNEL - EVALUATION/SUPERVISION 
Note:  AS 14.20.149 requires school districts to have a certificated employee evaluation 
system.  The School Board is required to consider information from students, parents, 
community members, classroom teachers, affected collective bargaining units, and 
administrators in the design and periodic review of the system.  The evaluation must be based 
on observation of the employee in the employee’s work place.  In addition, the law mandates a 
number of requirements for the system including the establishment of district performance 
standards, a minimum number of evaluations each year, the preparation and implementation of 
a plan of improvement, and opportunity for students, parents, community members, teachers, 
and administrators to provide information on the performance of the person being evaluated. 
Department of Education and Early Development regulations require a district’s certificated 
employee evaluation system to evaluate a teacher or administrator’s performance on applicable 
professional content standards as exemplary, proficient, basic, or unsatisfactory.  In addition, 
overall performance must be evaluated with these same four ratings.  No later than July 1, 
2016, a district shall adopt for teachers and administrators standards for performance based on 
student learning data. 4 AAC 04.205. A district shall report to the department not later than 
September 15th of each year evaluation results as to tenured and non-tenured teachers, 
administrators and special service providers and performance levels, as prescribed in 4 AAC 
19.055.The Educator Evaluation regulations are found at 4 AAC 19.010-19.099. 

The School Board believes that evaluations can provide important information relevant to 
employment decisions, help staff improve their professional skills, improve the effectiveness of 
instruction, and raise student achievement levels.  In accordance with the district’s certificated 
employee evaluation system, the Superintendent or designee shall evaluate certificated personnel 
annually, including teachers, administrators, and special service providers.  The evaluation 
system shall evaluate whether the certificated employee is exemplary, proficient, basic, or 
unsatisfactory on applicable content standards and in overall performance.  The district’s 
certificated employee evaluation system will incorporate those procedures and mandates required 
by law.  
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The district shall provide in-service training to all certificated employees subject to the 
evaluation system.  The training will assure inter-rater reliability and address the evaluation 
procedures, the standards used by the district in evaluating performance, and other information 
that may be helpful to a thorough understanding of the evaluation system.  
Individuals conducting an evaluation must hold a type B administrator certificate or be a site 
administrator under the supervision of a person with a type B certificate, be employed by the 
school district as an administrator, and complete training in the use of the district’s evaluation 
system. 
A certificated employee has a right to comment within 10 days on the evaluation and may not be 
retaliated against for doing so.  
The certificated employee evaluation system will be periodically reviewed.  The district will 
consider input from students, parents, community members, classroom teachers, affected 
collective bargaining units, and administrators.  The district will make a form, template, or 
checklist that the district uses in the evaluation of certificated employees available to the public, 
including posting the form, template, or checklist on the district’s website.  The posting will 
explain how the district has considered the input of these groups in the design of the evaluation 
system. 
(cf. 4116 - Probationary/Permanent Status Nontenured/Tenured) 
(cf. 4117.4 - Dismissal) 
(cf. 4117.6 - Nonretention) 
(cf. 4315.1 - Competence in Evaluation of Teachers) 
Legal Reference: 

ALASKA STATUTES 
14.20.149 Employee Evaluation 
14.08.111 Duties 
14.14.090 Duties of school boards 
23.40.070 Declaration of policy (PERA) 

ALASKA ADMINISTRATIVE CODE 
4 AAC 19.010-4 AAC 19.099  Evaluation of professional employees 
4 AAC 04.200 Professional content and performance standards 
4 AAC 04.205 District performance standards 

Revised  12/2025 
9/92 

AASB Policy Reference Manual 

 

BP 4117.2/4217.1/4317.2 - ALL PERSONNEL – RESIGNATION 
 
The Superintendent or designee is authorized to accept the written resignation of any employee 
on behalf of the School Board, and the resignation shall become effective immediately upon 

Deleted: annual 

Deleted: timely 

Deleted: .

Formatted: Strikethrough

Deleted: 3/2017

Deleted: CERTIFICATED 

Deleted: Note: The following sample policy sets forth two 
options regarding authority to accept resignations and should 
be revised as needed.… ... [1]
Deleted: ¶

Deleted: OPTION 1

Deleted: ¶



Page 28: [1] Deleted   Michael D. Caulfield   12/10/25 1:05:00 PM 
 

 



BP 4112.1 CERTIFICATED PERSONNEL - CONTRACTS

After January 1, the School Board may issue teacher contracts for the following school year. Contracts
shall be approved by the School Board and signed by at least two School Board members.

The School Board shall give or mail reemployment contracts to teachers who are not dismissed or
given notice of nonretention or layoff in accordance with law. If an employee fails to notify the
Superintendent or designee within 30 days after receipt of a contract of reemployment that he/she
accepts reemployment, the School Board shall consider the employee to have declined reemployment
and shall terminate the employee's services at the expiration of the existing contract. An employee on
family leave must comply with the 30-day deadline.

(cf. 4117.4 - Dismissals)

(cf. 4117.6 - Nonretention)

(cf. 4119.21 - Code of Ethics)

Legal Reference:

ALASKA STATUTES

14.20.130 Employment of teachers and administrators

14.20.145 Automatic Reemployment

14.20.158 Continued contract provisions

14.20.010 Teacher certificate required

14.20.020 Requirements for issuance of certificate

14.20.120 Statement of qualifications

14.20.215 Definitions

14.20.620 - 14.20.650 Interstate agreement on qualification of educational personnel

14.30.250 Teacher qualifications

ALASKA ADMINISTRATIVE CODE

4 AAC 05.080 School curriculum and personnel

4 AAC 12.300-4 AAC 12.900 Certification of professional personnel

4 AAC 18.010 Teachers' and administrators' contracts

4 AAC 18.021 Employment of substitute teachers

Adopted 1/21/2020

Chatham School District
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http://redirector.microscribepub.com/?cat=code&loc=ak&id=4&spec=18.021


BP 4112.5/4212.5/4312.5 SECURITY CHECK - All Personnel

The School Board desires to hire personnel whose background and behavior exemplifies a standard
deemed appropriate for individuals working with children.  Effort will be made to investigate the
background of applicants prior to hire in the district.  This investigation will include questions related to
an applicant's background and criminal history and may include a fingerprint check.

Falsification of information during the interview or on the application shall be grounds for immediate
removal from consideration for a position or dismissal from a currently held position.

Revised 9/01

Adopted: 5/13/10

Chatham School District
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AR 4112.5/4212.5/4312.5 SECURITY CHECK - All Personnel - REGULATION

1. No individual will be hired by the district until a  background investigation has been completed. 
Under emergency circumstances, the Superintendent can waive this requirement to allow someone to
work until the  investigation is complete.

2. No person who has ever been convicted, or plead guilty or no contest (including forfeiture of bail) to
a crime involving violence or sexual abuse will be hired by the district.

3. No person who has been convicted, or plead guilty or no contest (including forfeiture of bail) to (1) a
felony or (2) a crime or other violation involving a controlled substance within the five years preceding
the application, will be hired by the district.  If more than five years have elapsed since the crime or
violation, a person may apply pursuant to the following paragraph.

4. Applications from persons who have been convicted, or plead guilty or no contest (including
forfeiture or bail) to any crime or violation (excluding minor traffic violations) not covered in (2) nor (3)
will be considered by the Superintendent on a case by case basis and notice given to the School
Board prior to hire or being hired by the district.

5. If charges are pending, no action will be taken on the individual's application until disposition of the
charges.

Revised 9/01

Adopted: 5/13/10

Chatham School District
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BP 4112.6/4212.6/4312.6 PERSONNEL RECORDS - All Personnel

Personnel records shall be kept for all current employees and shall include information usually
expected in good personnel administration.  Records shall be kept for all former employees, including
such information as shall seem appropriate to the administration.

(cf. 1340 - Access to District Records)

(cf. 3580 - District Records)

(cf. 1312.1 - Complaints Concerning Personnel)

All personnel files are confidential and shall be available only to the employee, persons authorized by
the employee, the Superintendent or designee, and those individuals authorized by the Superintendent
or Board in accordance with administrative procedures.  School Board members may request to
review an employee's file at a personnel session of the Board.

Employees shall be notified whenever derogatory information is to be placed in their personnel files. 
Employee may review and comment on the contents of this personnel file.  Personnel records shall be
made available for inspection by the employee at an off-duty time.  Inspection shall take place in the
presence of an administrator.

Legal Reference:

ALASKA STATUTES

40.25.120 Inspection and copying of public records

23.40.070 Declaration of Policy (PERA)

14.20.149 Employee Evaluation

ALASKA ADMINISTRATIVE CODE

4 AAC 19.040  Use of the evaluation

COURT DECISIONS

Municipality of Anchorage v. Anchorage Daily News, 794 P.2d 584 (Alaska 1990)

City of Kenai v. Kenai Peninsula Newspapers, Inc., 642 P.2d 1316 (Alaska 1982)

Revised 1/09

Adopted: 5/13/10

Chatham School District
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https://www.akleg.gov/basis/statutes.asp?year=2013&title=40#40.25.110
https://www.akleg.gov/basis/statutes.asp?year=2013&title=23#23.40.070
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BP 4112.61/4212.61/4312 ALL PERSONNEL - EMPLOYMENT REFERENCES

The School Board desires to provide information about district employees to prospective employers
to the extent that such information is factual and does not violate an employee's privacy rights.

The Superintendent or designee is responsible for processing all requests for references, letters of
recommendation, or information about employee performance, including the causes or reasons for
separation regarding all district employees other than the Superintendent.

References which are not secured through the Superintendent or designee reflect the personal views
or opinions of the author and do not reflect the views of the District.

(cf. 4112.6 - Personnel Files)

(cf. 4117.5 - Termination Agreements)

Legal References: 

ALASKA STATUTES

AS 09.65.160 Job References

Adopted 1/21/2020 

Chatham School District
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BP 4112.10 EMPLOYMENT OF RETIRED TEACHERS - Personnel

Note: Effective November 8, 2018, AS 14.20.136 authorizes schools districts to hire retired teachers
in cases of teacher shortages. Retired teachers hired under this statutory provision may elect to
continue receiving TRS benefit payments during the period of reemployment. A contract for
reemployment of a retired teacher hired under AS 14.20.136 may not be for more than 12
consecutive months. If the teacher retired under the defined benefit retirement system, the teacher
must be retired for at least 60 days if 62 years of age or older, or at least six months if under 62
years of age, before reemployment. In addition, if the teacher is reemployed by the same district
that employed the teacher upon retirement, the teacher must certify that there was no prearranged
agreement with the school district to hire the teacher after retirement.

Prior to the hire of retired teachers under this statute, the school board must adopt a policy that
permits the employment of retired teachers who are qualified to teach in those disciplines or
specialties in which a shortage of teachers exists. The policy must describe the circumstances that
constitute the shortage.

This optional policy may be utilized by districts desiring to hire retired teachers in cases of teacher
shortages, as authorized by AS 14.20.136.

It is the policy of the Board that teacher vacancies be filled in a timely manner by qualified personnel.
The District administration is authorized to employ retired teachers in accordance with AS 14.20.136
in cases of teacher shortages, and to notify the Administrator of the Teachers’ Retirement System that
it is hiring retired teachers pursuant to that statutory provision.

The hiring of retired teachers is authorized in those disciplines or specialties in which a shortage of
teachers exists despite active recruitment efforts. A shortage is deemed to exist for those open
positions that the administration has been unable to fill with qualified candidates, despite recruitment,
public advertising for at least 10 business days, interviews, and the offering of positions to qualified
candidates, if any.

(cf. 4111 Recruitment and Selection)

Legal Reference

ALASKA STATUTES

14.20.136 Employment of member of teachers’ retirement system

14.25.043 Reemployment of retired members

14.20.165 Restoration of tenure rights

Revised 8/2020

Adopted 11/10/20
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AASB POLICY REFERENCE MANUAL UPDATE SERVICE 

2025 PERSONNEL SERIES 

INSTRUCTION SHEET 

 

NOTE:  This packet includes only those policy manual pages that have been revised, deleted or newly 

established.  Full text pages are included and are to be substituted as indicated below.  

 

This update constitutes a housecleaning of the 4000 Series – Personnel. Many updates include minor 

grammatical/titling/explanatory note changes that do not require Board approval. Titles of the series have 

been updated to better clarify whether they apply to certificated personnel, classified personnel, or 

supervisory/management personnel. This is accomplished by titling each policy with the appropriate label:  

 

1. All Personnel 

2. Certificated Personnel (4100 Numbers) 

3. Classified Personnel (4200 Numbers) 

4. Management and Supervisory Personnel (4300 Numbers) 

 

If the policy applies to more than one employee group, it has been assigned a policy number for each 

group.  

 

The following polices do not require formal board adoption: 

 
Formal Adoption Not Required – Grammatical/Titling/Explanatory Note Changes Only 

 
BP 4000 BP 4020 AR 4021 BP 4030 

E 4030 BP 4111.2/4211.2/4311.2 BP 4112.1/4312.1 AR 4112.5/4212.5/4312.5 

BP 4112.10 BP 4112.61/4212.61/4312.61 BP 4117.6 BP 4119.11/4219.11/4319.11  

E 4119.21 BP 4119.41/4219.41/4319.41 E 4119.42/4219.42/4319.42 BP 4131/4231/4313 

BP 4132/4232/4332 BP 4135/4235/4335 BP 4136/4236/4336 BP 4141/4241 

BP 4141.6/4241.6 BP 4143/4243 BP 4144/4244/4344 AR 4144/4244/4344 

BP 4151/4251/4351 BP 4154/4254/4354 AR 4154/4254/4354 E 4154/4254/4354 

BP 4156.3/4256.3/4356.3 BP 4157/4257/4357 BP 4161/4261/4361 AR 4161.1 

BP 4161.3 BP 4161.4/4261.4/4361.4 AR 4161.4/4261.4/4361.4 E 4161.4/4261.4/4361.4 

BP 4161.7/4261.7/4361.7 BP 4170/4270/4370 BP 4180/4280/4380 AR 4180/4280/4380 

BP 4213 BP 4215 BP 4216 BP 4218 

BP 4222 AR 4222 BP 4231 BP 4253 

BP 4300 BP 4313.2 BP 4315 BP 4315.1 

BP 4361.1    
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The following policies do require board approval: 

 
 

REPLACE/ADD FORMAL 

ADOPTION 

REQUIRED 

 

DESCRIPTION 

BP 4021 Yes This update clarifies that school bus driver testing may be accomplished through 

contracting with the transportation services provider. 

BP 4111/4211/4311 Yes ***Merge BP 4111 and BP 4211*** 

 

This update clarifies language regarding inquiries into protected information 

when hiring. It also authorizes the board to delegate the authority to make 

classified hires to the superintendent. This policy merges the previous BP 4211 

into a single policy.  
BP 4111.1/4211.1/4311.1 Yes ***Deleted Board Policy*** 

 

AASB recommends the deletion of the affirmative action policy, which includes 

problematic language regarding hiring preferences. Districts are encouraged to 

consult with legal counsel to discuss any proposed hiring preferences.  

BP 4112.5/4212.5/4312.5 Yes This update clarifies that school district volunteers must be subject to a 

background check, and that an omission on an application can be grounds for 

denial of hire (or dismissal). 

BP 4112.6/4212.6/4312.6 Yes This update clarifies when and how board members may review employee 

records and information. 

BP 4113 Yes This update provides additional guidance regarding the assignment of certificated 

personnel.  

BP 4115 Yes This update adds language to clarify that employees evaluating certificated 

personnel in the District must hold a Type B administrator certificate.  

BP 4117.2/4217.1/4317.2 Yes ***Merge BP 4117.2 and BP 4217.2*** 

 

This update simplifies the process by which an employee resigns. It also merges 

the classified and certified resignation policies.  

BP 4117.4 Yes This update codifies the requirement established by the Alaska Supreme Court 

that certified employees may call witnesses at a pre-termination hearing.   

BP 4118 Yes This update clarifies what constitutes progressive discipline, and that 

reassignment is not necessarily disciplinary.  

BP 4119.3/4219.3/4319.3 Yes This update requires that, as a best practice, job descriptions should be reviewed 

and updated annually.  

BP 4119.12/4219.12/4319.12 Yes This update updates harassment language to fit best practices, including that it 

relates to all school district activities and facilities.  

BP 4119.22/4219.22/4319.22 Yes This update simplifies the model dress code policy, and applies it to all 

personnel.  

BP 4119.23/4219.23/4319.23 Yes This update clarifies best practices regarding the release of unauthorized District 

information.  

BP 4119.25/4219.25/4319.25 Yes This update clarifies that the District may regulate political activity on school 

property at any time (not just during the instructional day) in accordance with 

law. 

BP 4122 Yes This update requires that the superintendent establish criteria for a student 

teacher program. 

BP 4133/4233/4333 Yes This update provides clearer guidelines on employee use of travel expenses. 

BP 4156.2/4256.2/4356.2 Yes This update removes specific language regarding the use of monetary awards 

for employees, while still allowing latitude to provide employee awards, as 

appropriate.  

BP 4158/4258/4358 Yes This update requires that the superintendent or designee is made aware of all 

police reports made by personnel in the course of their duties. 
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REPLACE/ADD FORMAL 

ADOPTION 

REQUIRED 

 

DESCRIPTION 

BP 4159/4259/4359 Yes This update includes best practice language regarding employee mental health 

support.  

AR 4161/4261/4361 Yes ***Deleted Administrative Regulation*** 

 

AASB recommends the deletion of the model regulation regarding COVID 19 

emergency and sick leave, which is no longer applicable.  

BP 4161.1 Yes This update revises BP 4161.1 to clarify and better align it with state law. 

BP 4161.2/4261.2/4361.2 Yes This update clarifies that personnel leave is generally a bargained for benefit. It 

also removes a restriction tying it to sick leave, which is an independent type of 

leave. 

BP 4212 Yes Related to BP 4111/4211/4311, this update clarifies that the Board may delegate 

the hire of classified employees to the superintendent.  

BP 4314 Yes This update simplifies language regarding the assignment of management and 

supervisory staff, while removing the recommendation that management 

personnel routinely apply for transfers (or be involuntarily rotated).  
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14-Month School Year Calendar Template
https://www.vertex42.com/calendars/school-calendar.html

Year: 2026 Start Month: 7 Start Day: 1 1: Sunday, 2: Monday
Option A

Chatham School District

2026-2027
July 26 School Year Calendar August 26

Su M Tu W Th F Sa Su M Tu W Th F Sa
1 2 3 4 1

5 6 7 8 9 10 11 2 3 4 5 6 7 8
12 13 14 15 16 17 18 9 10 11 12 13 14 15
19 20 21 22 23 24 25 16 17 18 19 20 21 22
26 27 28 29 30 31 23 24 25 26 27 28 29

30 31
11

September 26 October 26 November 26 December 26
Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa

1 2 3 4 5 1 2 3 1 2 3 4 5 6 7 1 2 3 4 5
6 7 8 9 10 11 12 4 5 6 7 8 9 10 8 9 10 11 12 13 14 6 7 8 9 10 11 12

13 14 15 16 17 18 19 11 12 13 14 15 16 17 15 16 17 18 19 20 21 13 14 15 16 17 18 19
20 21 22 23 24 25 26 18 19 20 21 22 23 24 22 23 24 25 26 27 28 20 21 22 23 24 25 26
27 28 29 30 25 26 27 28 29 30 31 29 30 27 28 29 30 31

21 22 19 14
January 27 February 27 March 27 April 27

Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa
1 2 1 2 3 4 5 6 1 2 3 4 5 6 1 2 3

3 4 5 6 7 8 9 7 8 9 10 11 12 13 7 8 9 10 11 12 13 4 5 6 7 8 9 10
10 11 12 13 14 15 16 14 15 16 17 18 19 20 14 15 16 17 18 19 20 11 12 13 14 15 16 17
17 18 19 20 21 22 23 21 22 23 24 25 26 27 21 22 23 24 25 26 27 18 19 20 21 22 23 24
24 25 26 27 28 29 30 28 28 29 30 31 25 26 27 28 29 30
31

20 20 18 22
May 27 June 27 July 27 August 27

Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa
1 1 2 3 4 5 1 2 3 1 2 3 4 5 6 7

2 3 4 5 6 7 8 6 7 8 9 10 11 12 4 5 6 7 8 9 10 8 9 10 11 12 13 14
9 10 11 12 13 14 15 13 14 15 16 17 18 19 11 12 13 14 15 16 17 15 16 17 18 19 20 21

16 17 18 19 20 21 22 20 21 22 23 24 25 26 18 19 20 21 22 23 24 22 23 24 25 26 27 28
23 24 25 26 27 28 29 27 28 29 30 25 26 27 28 29 30 31 29 30 31
30 31

20
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INSTRUCTIONS

«  Choose the year and start month

«  You can insert an image of your school logo in this space

Vacation Days «  Use the Format Painter to copy the format from one cell to another
School Closed Holiday
First Day of Class 08/262026
Last Day of Class 05/27/2027
Inservice Days «  Copy and paste these Shapes to highlight specific days
Teacher Work Days
Parent Teacher Conference Days
End of Quarter Changing the color scheme. You can change the color scheme by going to 

Page Layout > Themes > Colors.

«  Make a list of important dates. Enter dates as text by entering an apostrophe 
before the date, like 'Aug 8

Student Contact Days: 172
Inservice Days: 8
Teacher Works: 5
Parent Teacher Conferences: 2 Publishing your calendar. If you want to publish a school calendar, you 

must ensure that it includes the following note and URL in the footer: 
Calendar Templates by Vertex42.com - https://www.vertex42.
com/calendars/school-calendar.html

Total Days: 187

Q1: 48 SD:41
Q2: 39 SD: 37
Q3: 44 SD: 41 Converting the calendar to a PDF. To publish a school calendar on your 

website, you should first convert it to a PDF. The best way to do that is to either 
print to a PDF driver, or in Excel 2010/2013 you can go to Save As and select 
PDF.

Q4: 56 SD: 53

View the Print Area. To view the current print area, first view the Print Preview 
(Ctrl+P) then return to the Home tab. Or, go to View > Page Break Preview. The 
print area will become highlighted with a dashed line. To choose a new print 
area, select the cells you want to include and go to Page Layout > Print Area > 
Set Print Area.
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14-Month School Year Calendar Template
https://www.vertex42.com/calendars/school-calendar.html

Year: 2026 Start Month: 7 Start Day: 1 1: Sunday, 2: Monday

Option B
Chatham School District

2026-2027
July 26 School Year Calendar August 26

Su M Tu W Th F Sa Su M Tu W Th F Sa
1 2 3 4 1

5 6 7 8 9 10 11 2 3 4 5 6 7 8
12 13 14 15 16 17 18 9 10 11 12 13 14 15
19 20 21 22 23 24 25 16 17 18 19 20 21 22
26 27 28 29 30 31 23 24 25 26 27 28 29

30 31
11

September 26 October 26 November 26 December 26
Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa

1 2 3 4 5 1 2 3 1 2 3 4 5 6 7 1 2 3 4 5
6 7 8 9 10 11 12 4 5 6 7 8 9 10 8 9 10 11 12 13 14 6 7 8 9 10 11 12

13 14 15 16 17 18 19 11 12 13 14 15 16 17 15 16 17 18 19 20 21 13 14 15 16 17 18 19
20 21 22 23 24 25 26 18 19 20 21 22 23 24 22 23 24 25 26 27 28 20 21 22 23 24 25 26
27 28 29 30 25 26 27 28 29 30 31 29 30 27 28 29 30 31

21 22 19 14
January 27 February 27 March 27 April 27

Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa
1 2 1 2 3 4 5 6 1 2 3 4 5 6 1 2 3

3 4 5 6 7 8 9 7 8 9 10 11 12 13 7 8 9 10 11 12 13 4 5 6 7 8 9 10
10 11 12 13 14 15 16 14 15 16 17 18 19 20 14 15 16 17 18 19 20 11 12 13 14 15 16 17
17 18 19 20 21 22 23 21 22 23 24 25 26 27 21 22 23 24 25 26 27 18 19 20 21 22 23 24
24 25 26 27 28 29 30 28 28 29 30 31 25 26 27 28 29 30
31

20 20 18 22
May 27 June 27 July 27 August 27

Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa Su M Tu W Th F Sa
1 1 2 3 4 5 1 2 3 1 2 3 4 5 6 7

2 3 4 5 6 7 8 6 7 8 9 10 11 12 4 5 6 7 8 9 10 8 9 10 11 12 13 14
9 10 11 12 13 14 15 13 14 15 16 17 18 19 11 12 13 14 15 16 17 15 16 17 18 19 20 21

16 17 18 19 20 21 22 20 21 22 23 24 25 26 18 19 20 21 22 23 24 22 23 24 25 26 27 28
23 24 25 26 27 28 29 27 28 29 30 25 26 27 28 29 30 31 29 30 31
30 31
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00-049Calendar Template by Vertex42.com 00-049https://www.vertex42.com/calendars/school-calendar.html

INSTRUCTIONS

«  Choose the year and start month

«  You can insert an image of your school logo in this space

Vacation Days «  Use the Format Painter to copy the format from one cell to another
School Closed Holiday
First Day of Class 09/02/2026
Last Day of Class 05/27/2027
Inservice Days «  Copy and paste these Shapes to highlight specific days
Teacher Work Days
Parent Teacher Conference Days
End of Quarter Changing the color scheme. You can change the color scheme by going to 

Page Layout > Themes > Colors.

«  Make a list of important dates. Enter dates as text by entering an apostrophe 
before the date, like 'Aug 8

Student Cotact Days: 161
Inservice Days: 13
Teacher Work Days: 6
Parent Conferences: 2 Publishing your calendar. If you want to publish a school calendar, you 

must ensure that it includes the following note and URL in the footer: 
Calendar Templates by Vertex42.com - https://www.vertex42.
com/calendars/school-calendar.html

Total Days: 182

Q1:48 SD: 35
Q2: 39 SD:37
Q3: 44 SD: 41 Converting the calendar to a PDF. To publish a school calendar on your 

website, you should first convert it to a PDF. The best way to do that is to either 
print to a PDF driver, or in Excel 2010/2013 you can go to Save As and select 
PDF.

Q4: 51 SD: 48

View the Print Area. To view the current print area, first view the Print Preview 
(Ctrl+P) then return to the Home tab. Or, go to View > Page Break Preview. The 
print area will become highlighted with a dashed line. To choose a new print 
area, select the cells you want to include and go to Page Layout > Print Area > 
Set Print Area.



 

 
 

 

Department of Education 
& Early Development 

 
OFFICE OF THE COMMISSIONER 
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May 20, 2026 
 
David Langford, Superintendent 
Chatham School District 
PO Box 109 
Angoon, AK 99820 
 
Dear Mr. Langford, 
 
Thank you for working with the department to reconcile the district’s ADM appeal information. 
After further review of the data provided by the district, DEED identified differences in the 
ADM reporting related to student membership values, previously unreported PreK students, and 
two intensive students that were not included in the original submission. 
 
A significant portion of the adjustment resulted from students being reported at reduced ADM 
values, including instances where students who would typically generate a 1.0 ADM were 
reported at .75 ADM. As a result, the district’s submitted ADM was lower than what the 
department’s reconciliation ultimately calculated based on the supporting information provided. 
 
Based on the department’s analysis, the total calculated difference would equate to 
approximately $321,784 in additional funding. In an effort to resolve this matter collaboratively 
and provide the district with timely support, the department would like to propose a settlement 
amount of $200,000 as a full and final resolution of the appeal. 
 
We understand the district is experiencing financial challenges and appreciate the importance of 
providing certainty as you work through the remainder of the fiscal year. Our hope is that this 
proposal allows both the district and department to move forward in a positive and productive 
manner. 
 
Please let us know if the district would be willing to accept this proposed resolution. 
 
Sincerely, 

 
Deena M. Bishop, Ed. D. 
Commissioner 
 
cc: Jared De Lara, School Finance Specialist II 
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